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Microsoft Word 2010 - Level 1

GETTING HELP

: : INFocus

While the interface in Microsoft Word is intuitive and easy
to use, there will always be aspects that you don’t quite
understand and require assistance with. This is where Help
comes in, and Microsoft Word provides it in many ways and
locations.

In this booklet you will:

gain an understanding of Help

learn how to access the Help window
learn how to browse for Help

learn how to return to the Home page
learn how to use the Table of Contents
learn how to search using keywords
learn how to disconnect online help
learn how to print a help topic

learn how to use screen tips to access help
learn how to use dialog box help

gain an understanding of sources of help
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UNDERSTANDING HOW HELP WORKS

Microsoft Office 2010 contains a wide Help button @ in the Word window or the
range of help facilities and options for you Help button in a dialog box, or point to a
to use. The main access point for Help is command on the ribbon and press [f1] to get
window appears when you click on the
(@ Word Help
(1] CoXON BAEC
e l * O Search =
Helpand Howe- 1o
E:a ice [ search support E oing
downloads | irmages | ternplates

Getting started with Word 2010

* Creating documents with Word 2010
* Reading documents
= Actrvating Word

* Introducing the Backstage view

Browse Word 2010 support

Collabaration * Formatting
® Creating documents  ® Getting started with Word
= File migration

see all

Help tools
Search
controls

Help topics

Status Bar
Connected to
Office.com

Scroll Bars
and Arrows

These tools are provided to make working with Help easier. They include back
and forward buttons that you can use to step through the topics that you've
researched, and a print button. You can even magnify the text if it is too small.

The search tools include a text box that you can use to enter search topics and
a drop-down list that enables you to specify the content in which you want to
search.

These are a list of topics that may be related to the subject on which you
searched. Initially the list includes commonly accessed topics — when you click
on one of these, all topics related to the general function will appear. To
display a list of all Help topics from the initial Help window, click on see all. If
you are online, many of these topics are retrieved from the Microsoft website.

The Status Bar displays the current location of the insertion point, including
page number, section humber, column, and so on. It can also be used to
access navigation commands such as Go To.

This indicates whether or not you are connected to Office.com via Internet
Explorer. It also operates as a button that you can use to change the
connection status.

(Not shown in the above example but will appear to the right of the Help
window when a topic has more information than can display in the window.)
The Scroll bar indicates your current position in the Word Help window and
lets you move to other positions in Help by clicking or dragging. The arrows
can also be used to move up or down through the information.
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ACCESSING THE HELP WINDOW

The Word Help window can be accessed box can be accessed by clicking on Help
from many places in Word. General hg[p in the dialog box, and command-specific
can be accessed by clicking on Help @ in help can be accessed by pointing to a
the Word window. Help for a specific dialog command and pressing [1].
@ Word Help oo
Try This Yourself: DLREN BNE L B
- 2 Search -
Before starting this exercise e )
® @ you MUST ensure Word has BAOFITE | seurn suvpon & oing
& & started...ensure that you downloads | images | tamplates

have a document open...

Recommended

1 Click on Help @) to display

Lpply strikethrough formatting

the Word Help window artice =
This lists general interest S

topics because you haven't Preview and print a e

searched from a specific o

command or dialog box... artice

2 Click on close to close
the Word Help window

. B Getting started wipstoem-tmad ]
3 Click on the dialog box © CZED (= 2
launcher = in the Font L‘ | EtEea BNes g
- Search -
group on the Home tab to e -
. . P Wiond 2010 Hom e » Wiord 2010 Help and How-40 » Formatting .
display the Font dialog box | ey = T
) . Eln- | Search Support br]g
4 CIICk on Help to dlsplay a downloads | images | templates
the Word Help window with
suggestions for formatting Add ar remove text effects =
teCh nlques You can change the look of your text by changing its fill, changing its outline, or
5 C||Ck on Close and adding effects, such as shadows, reflections, or glows.
then click on [CanceI] NOTE  You can alsa apply text effects to \Wardar. -
6 Point to Text Effects [\~ in Inthis artcle
the Font group then press o Ade an effectto fext
& Rermove an effect from text
This gives you specific help Add an effect to text
abOUt text effeCts 1. Selectthe text that you want to add an effect to.
7 Click on close to close 2. Onthe Home tab, in the Font group, click Text Effect.
the Word Help window CabaBody ~[11 +| A" a7 | Aav | B I
Al wiard | | @ Connected to Office.com ¥

G L

For Your Reference... Handy to Know...
To access Help, either: e Help isn't available directly for every
e Click on Help @ command button on the ribbon. Point
e Open a dialog box and click on Help to a command and wait for the tooltip
to appear. This includes a description
e Point to a command and press of the tool and, if specific help is

available, the text Press F1 for more
help will appear below the description.
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BROWSING FOR HELP

When you first open the Word Help
window, no matter how you access it, you
are presented with a series of topics that
you can open and read through. The Word

Microsoft Word 2010 - Level 1

Help window comes with a series of buttons
that you can use to navigate Help topics,

movin

g backwards and forwards between

them as you like.

@) Word Help [E=IER
Try This Yourself: CoOWOA BASQ
+ P Search -
£ o Befort? starting this DLORfEE oo Q
n- E EXercise you MUST eénsure dowenloads | images | templates
o Word has started...

N =

Click on Help @) to display
the Word Help window
Click on see all to display
a full list of Word Help
topics

Click on Security and

Word 2010 Help and How-to

Accessibility

Add-ins

Collaboration

Digital IDs and signatures
Field codes

File migration

Getting help

Headers, footers, and page
numbers

Activating Word
Charts

Creating documents

Equations

File management
Farrnatting

Getting started with Yford
Installing

privacy to dlSpIay a series tdail merge ::egaek?reaks and section
Of toplcs Covering Secu rity Page setup Pictures and Clip Art b
and privacy S (v =
CI'Ck On Enable or Eﬁelling,gramman and ':‘__') = @,} @) fat ﬁ AL @ @ i
disable macros in Office Tl b ot o o

- ar \Word 2010 Home > Wiord 2010 Help a nd How-to > Security and priva -
files to see the help about Ao | i_‘goﬁ_wp = 5
thIS tOpIC o, |Ce Search Support blng =

) . downloads | images | templates
Click on Macro settings e
explained Enable or disable macros in Office files
Thls takes yOU to SpeCiﬁC Amacro i a series of commands that you can use to autornate a repeated
help - task, and can be runwhen you have to perform the task. This article has

) infarmation aboutthe risks involved when you waork with macros, and you can
C||Ck on the tOp Of page learn about how to enahble or disable macros in the Trust Center.
link beneath the topic to

In thi |

return to the top of the s artele

. % Enable macros when the Message Bar appears
Wi ndOW 4 Enable macros in the Backstage view
C||Ck On BaCk T Severa| % Enable macros for ane time when the Security Warning appears

& & Change macro setings in the Trost Center
times to step back through & Macro seftings explained
the pages y(l;)u have g % Whatis a macro, who rakes thern, and what is the security risk?
browsed - Enable macros when the Message Bar appears
Click on Forward || to :
Allwiord ‘ | @ connected to Office,com i

return to the topic details

Close the Word Help
window

(4

For Your Reference...

Hand

y to Know...

To browse for Help: e You may have noticed that hyperlinks
1. Click on Help @ in Word Help are coloured blue
2. Click on a topic link whereas normal text is black. If you
3. Click on Back [@| or Forward | to point to a hyperlink, the mouse pointer
step through the pages that have been will change to a pointing hand {.
viewed
© Learning and Development Service Page 5 Getting help




Microsoft Word 2010 - Level 1

RETURNING TO THE HOME PAGE

When you browse through Help, you can several ways that you can skip straight back
follow links and related topics and to the Home page. From here you can start
suddenly end up in a screen a long way your browsing afresh and choose another
from home. The Word Help window has topic from those offered on the main page.
. (@ Word Help [E=SREERT)
Try This Yourself: PLRAOR AA® e E
~ B Search -

Before starting this exercise
you MUST ensure Word has
started...

Open
File

Click on Help @) to display
the Word Help window

Click on Reading
documents to display the
related help topics

3 Click on Read documents
in Word to display the help
information

Notice that the grey bar
above the Office header
area contains the names of
the links that you have
followed...

4 Click on Word 2010 Home
in the grey bar to return to
the home page

5 Click on Introducing the
Backstage view

6 Scroll down to read through
the text
As you scroll, the link at the
top is hidden, but there is
an alternative...

7 Click on Home |@] in the
toolbar to return to the
home page

N =

8 Close the Word Help
window

3

'Word 2010 Home = Word 2010 Help and How-to > Reading documents ]
-4

égOfﬁEg Search Support E bl’13

downloads | images | templates

m

Read documents in Word

Full Screen Reading view is optimized for reading a document on the computer
screen. In Full Screen Reading view, you also have the option of seeing the
document as it would appear on a printed page.

©
G @ Word Help (=2 [t

ROt GAS R B

- SO Search ~

TP To quickly return to your document from the Backstage view, click the
Home tab, or press ESC on your keyboard

D
The File tab replaces the Microsoft Office Button C" and the File menu used
in earlier releases of Microsoft Office

What do you want to know?

+ Where is the tab located?
+ What do | see when | click the tab?

Where is the File tab located?

The File tab is located in the upper-left comer of Microsoft Office 2010
programs
W90 Documantl - Mcrosch Werd
[ e
™ igoan il <K N A % EE RO 8 [
g-hxx B-¥-A- [EEE - |

eeeee

TP To quickly return to your document from Backstage view, click the Home
tab, or press ESC on your keyboard

All Word ‘ ° Connected to Office.com -
J

For Your Reference...

To return to the Help home page:
1. Click on Word Home
Or
Click on Home |&

Handy to Know...

e If you find the text in the Word Help
window a bit difficult to read, you can
click on Change Font Size a and

select a larger size.

© Learning and Development Service
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USING THE TABLE OF CONTENTS

If you're not exactly sure what the name of
the topic is that you need help on, or you
just want to find out more about Microsoft
Word, you can use the Table of Contents.

Microsoft Word 2010 - Level 1

topics that you can open and explore to find
information and answers to your problems.
The Table of Contents is displayed in a
task pane to the left of the Word Help

This feature provides an expandable list of window.
@) Word Help oo
Try This Yourself: RO GALe [
-~ P Search ~
Before starting this —— - —
5 ) exercise you MUST @ Activating Word M £a.Office | search suspor: B oing
Ty dd-ins
8. l ensure WOFd has gzham downloads | images | templates

started...

Click on Help [@ to
display the Word
Help window

Click on Show Table
of Contents |@| to
expand the Word
Help window and
display the Table of
Contents

Click on Charts

The subtopics will be
listed...

Click on Available
chart types

The Help information
will appear on the
right...

Click on another topic
in the Table of
Contents and follow a
link to another topic

Click on Hide Table
of Contents |

Close the Word Help
window

& Collaboration
@Creahng documents
@Digital IDs and signatures

@Equanons

@ Field codes

@F\Ie management

@F\Ie migration

@Furmatﬁng

@Gemng help

@Get‘h’ng started with Word
@Headars, footers, and page numbers

@Insm\lmg

@Mai\ merge

@Page breaks and section breaks
@Page setup

@P\cmres and Clip Art
@Readmg documents

m

@Saving and printing
@/Sacuritg'I and privacy -~

Getting started with Word 2010
L | = Creating documents with Word 2010
©
Browse Word 2010 support
= Collaboration

= Creating documents
® File migration

= Reading documents
= Activating Word
® Introducing the Backstage view

= Formatting
= Getting started with Word

seeall

All Word ‘

| @ Connected to Office.com |

©
©

Table of Contents
@Accesab\lity
@Acﬁvaﬁng Word
@ Add-ins

(g Charts

OQuwck Start: Add a chart to your documer
ewhen should I use a SmartArt graphic an
gchange the chart type of an existing cha|
ondd or remaove a secondary axis in a cha
ochange the display of chart axes
ochange the layout or style of a chart
ochange the scale of the depth (series) a:
echange the scale of the horizontal (catec—!
ochange the scale of the vertical {value) z
OAvailabIe chart types

Collaboration

v X

m

@
@
@Dlgnﬁl IDs and signatures

@Equaﬁons

@ Field codes
@Flle management

@File migration

Creating documents

@Formatﬁng il
Rl P T— |
For Your Reference... Handy to Know...

To use the Table of Contents:
1. Click on Help @

2. Click on Show Table of Contents &

3. Click on a topic

e The closed book icon @ in the Table of
Contents indicates that there is more

information to be seen. The question

mark @ indicates that a help page

follows.
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SEARCHING USING KEYWORDS

includes a text box in which you type the
keywords or phrases that you want to search
for. The search will return help topics,

If you know exactly what you want help
for, and the topic isn't listed in the Table
of Contents or in the Word Help window,

you can search for the information using
keywords. The Word Help window

relevant articles, templates, training

courses, and links to other sites.

H ord He =B
Try This Yourself: © Wort e e s
DENHM GME e B
columns ~ B Search ~ |
= Before starting this Vs 23 eme B
gE exercise you MUST ensure SROfficé | sesren suppon [ ving
o WOI’d haS Started, 0o downloads | images | templates

Click on Help @) to display
the Word Help window

Click in the Search box at
the top of the window,
type columns and press

or click on [Search]

The articles relating to
columns will be
displayed...

N =

Search results for: columns

m

Create newsletter columns
Article | What do you want to do? Format a document with newsletter col...

Add or delete a table
Article | What do you want to do? Insert a table Draw a table Convert text...

Available chart types
Article | Microsoft Excel supports many types of charts to help you display...

Insert or delete a section break

Article | You can use section breaks to change the layout or formatting of...
Check spelling using Arabic strict spelling rules

Article | You can now check the spelling of Arabic using strict spelling rule...
Check spelling using Russian strict spelling rules

Article | You can now check the spelling of Russian using strict spelling ru...
Check Portuguese spelling using post-reform spelling rules

Article | You can now check the spelling of Portuguese using the pre-refo...

Check Brazilian Portuguese spellina using nost-reform soelling rule:

3 SCFO|| down the I|St and — :n‘me You can now chee| &) Word Help lE‘ﬁg
. . or ® ) & @ g
examine the topics that . e LA e B
have been returned e o 3
4 Click on Add or delete a BROFfICE [ scoren suppor Bl ong

table to display the topic

You can also search
specific parts of the Online
content...

5 Type texture in the text
box, then click on the drop
arrow - for Search and

select Word Templates
Click on [Search] to

display the Word templates
with texture

7  Close the Word Help
window

downloads | images | templates

Search results for: texture

Template
rdndn(rey (11

Template
Agkgkglc)]

thank you

-
T
e Template )
2008 Wrdrdnirey 25

Graduation announcement (Textures design)

Graduation thank you card (Textures design)

Graduation ceremony invitation (Textures design)

m

o

‘ @ Connected to Office.com |

G Ward Templates ‘
.

J

For Your Reference...

Handy to Know...

To search using keywords:
1. Click on Help @
2. Click in the keyword text box
3. Type the keyword and press
4,

Click on the drop arrow - for Search
and select specific content if required

e You can search for specific downloads,

images and templates at
office.microsoft.com by typing a
keyword into the Search Support text
box near the top of the Word Help
window and then clicking on
downloads, images or templates.

© Learning and Development Service
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DISCONNECTING ONLINE HELP

Many of the Microsoft Office help tools and content. This will avoid any delays during
facilities will attempt to make contact with searching caused by a slow internet
specific websites and therefore require an connection and reduce the likelihood of
internet connection. If you don't want this exceeding any download limit that you may
to happen, you can disable access to online have.
@) Word Help Hﬁu
Try This Yourself: T CROM BASQ B

~ SO Search ~

Help and How-to

Before starting this
exercise you MUST ensure
Word has started...

égofﬁe‘é— Search Support E bﬁ']g

downloads | images | templates

Open
File

Getting started with Word 2010
q =] q
1 CIICk el Help Q‘ to dISplay —| ® Creating documents with Word 2010
the Word Help W|nd0W L‘e * Reading documents

* Activating Word
If you are Connected to ® Introducing the Backstage view

Office.com, this will be
displayed in the bottom

Browse Word 2010 support

i * Collaboration = Formatting
rlg_ht corner Of the * Creating documents = Getting started with Word
WIndOW. P * File migration
see all
2 Click on Connected to
Office.com to display a
menu
3 All Word | | @ Connected to Dﬁi'\ce‘mm i
Select Show content Connection status: X
only from this computer | Show content from Office.com
Show content only from this computer
Offline will appear in the 9 @ Elsin these options..

status bar. Any searches
you do now will be through
content that has been
loaded onto your computer

X . i Working in a different Tables
during installation. language
Charts Equations
YOU can reconnect to Pict:res and Clip Art Hiadters footers, and page
Office.com just as easily... ° numbers
A A Page breaks and section SmartArt graphics
Click on Offline to poget < rtgrap —_—
redisplay the menu Word Heln | @ormine |
5 Select Show content é
from Office.com to
reconnect
6 Close the Word Help
window
For Your Reference... Handy to Know...
To disconnect online help: e If you leave Word Help offline, it will
1. Click on Connected to Office.com stay that way until you reconnect it.
2. Select Show content only from this
computer

© Learning and Development Service Page 9 Getting help



Microsoft Word 2010 - Level 1

PRINTING A HELP TOPIC

When accessing help topics in Word, you find it easier to print the help details. The
may find information that you expect to Print button is provided along with the other
use quite often or that you want to pass on Word Help tools to make this possible. You
to someone else. In this situation, you may can print one page or entire topics.
e @) Word Help [ESREERT)
Try This Yourself: CoROM BAER B
gradient v P Search ~
Before Starting this Word 2010 Home = Word 2010 Help and How-to > Fictures and Cip Art o
= ; N
g @ exercise you MUST 03 YFES [seormnsumpon B oing H
&L ensure Word has B
ownloads | images | templates
started...

1 Click on Help E to Add a gradient fill to a shape

dISpIay the Word You can apply a gradient fill to shapes, text boxes, and SmartArt graphics in Excel,
Help window PowerPoint, and Word. A gradient fill is a shape fill that gradually changes from

- H one color to another across the surface ofthe shape
2 Type gradient in the

keyword Sea rch text For more information about how to add a shape, see Add, change, or delete
box and press eees
3 Click on Add a In this article
gradient fill to a 4 Overview of gradient fills
sha e to dIS Ia the < Apply a simple gradient to your shape
p p y < Apply a buil-in gradient to your shape
help page 4 Create a custom gradient fill for your shape
4 Click on Print (&l to
display the Print Overview of gradient fills
dialog box 2
) All Word ‘ | @ Connected to Office.com )
5 Click on Pages under < o
Page Range so that o (& print )
only the first page ——
will be printed = | Oations
q - Select Printer
6 CIICk o [Prlnt] EHP Color Laserlet CP4005 PCLG |
The help [nformatlon Microsoft XP5S Document Writer
will be reformatted to #hSend To OneNote 2010
fit your paper and < | ] LC
then printed... Satus:  Ready [l Pint to i
Location:
7 Close the Word Help Comment:
WI ndOW Page Range
@ Al MNumber of copies: @‘
Selection Current Page
(©) Pages: 1 [¥] Collate — —
Enter either a single page number or a single jili' jjﬂ
page range. For example, 512
[Pt ][ Cancsl J[ ooy |
For Your Reference... Handy to Know...
To print a help topic: e If you want to print only a section of a
1. Display the help information in the help page, select the text using the
Word Help window mouse before clicking on Print & . In
2. Click on Print & the Print dialog box, click on
3. Click on [Print] Selection and then click on [Print].

Only the selected text will be printed.
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WORKING WITH SCREEN TIPS

One way of finding out more information tell you the name of the tool and describe its
about commands on the ribbon is to use purpose. In others, they provide direct
the screen tips. These are small windows access to additional help information. Screen
of information that appear when you point tips are also referred to as tool tips.
to a command. In some cases, they just
o rt Page Layout References Mailings Review View
Try This Yourself: - . o
Calibri (Body) -~ 11 ~ A A | Aa~ l% A= S T
Before starting this R = v & B=a=
exercise you MUST ensure Font L Feragrepn

Open
File

Word has started... Clear Formatting 7

Clear all the formatting from the
selection, leaving only the plain

1 Point to Clear Formatting text.
‘@ in the Font group on e Press F1 for more help.
the Home tab

The screen tip for the tool
will be displayed. This

includes the name of the 9 (@) Word Help P
t_“o_ol, a description of what RN BA® B
it is used for, and a prompt =F S vee— -
to Press F1 for more he/p Word 2010 Home > Word 2010 Help and How-to > Formatting -
This p_rompt {fv_d/cates that 00 (FFEE [semcrsommon B
there i SpeCIfIC help for downloads | images | templates
this topic...
2 Press Clear formatting
The help information will To getrid of all the styles, text effects, and font formatting in your document, dothe | _
be dISp/ayed... following I
3 Close the Word Help 1. Selectthe textthat you wantto clear the formatting from. Or press CTRL+A
window to select evenything in the document.

2. Onthe Home tab, in the Font group, click Clear Formatting.

Calibri@ody) ~ 11 ~ A" A" | Aav
B 7 U -aex, x* [A-%-A- T

Font

NOTE The Clear Formatting command will not remove highlighting from your
text To clear highlighting, selectthe highlighted text, and then click the arrow nesxt
to Text Highlight Color and click Ho Color.

Calibri Body) = 11 = A" A7 | Aav | &} .
All Word | | @ Connected to Office.com il
For Your Reference... Handy to Know...
To access help via screen tips: e If you point to a formatting option in a
1. Point to the tool gallery such as Styles, the tool tip will
2. Press for more help if the option is display the name of the style. It will
available also temporarily reformat your text

using Live Preview, so don't be
alarmed. The text will change back to
its original format when you move the
mouse away from the gallery.

© Learning and Development Service Page 11 Getting help
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DIALOG BOX HELP

Another way that you can access help is You can click on these links to find more
via dialog boxes. When you access help via information or perform a keyword search if
a dialog box, suggestions specific to the necessary.

purpose of the dialog box will be displayed.

@ Word Help o
Try This Yourself: COREOM BAS R |

~ R Search -

Help and How-to .

Elgofﬁa‘é Search Support E br]g

downloads | images | templates

Before starting this exercise
you MUST ensure Word has
started...

Open
File

Recommended

1 Click on the dialog box
launcher = in the Font e
group on the Home tab to Make et superscript or subscript
display the Font dialog box e

Preview and print a file

2 Click on Help to display Atice
the Word Help window Setthe defau't font

The suggestions relate to o
formatting commands...

3 Click on [Cancel] in the Geming St S ==
dialog box to close it L‘ - j[eccea aaee [
If the Word Help window is e . WSS
obscuring the dialog box, AlWord | S 3
you can drag it out of the BAOFfICE | sesren supoor B ong
Way by ItS tltle bar. e downloads | images | templates

4 Click on the dialog box
launcher == in the
Paragraph group on the o
Home tab tO dISp|ay the Create a document to be used by previous versiens of Word
Paragraph dialog box e

5 Click on Help to display
?queStions for paragraph Getting started with Word 2010
ormatting topics

G Close the Word Help L‘ L i oo i e 2210
window e = Activating Word

Introducing the Backstage view
7 Click on [Cancel] to close
the Paragraph dialog box Browse Word 2010 support

All Word | | °(onnedcdtn Office.com |

Apply strikethrough formatting

n

Recommended

Adjust the spaces between lines or paragraphs

n

o J

For Your Reference... Handy to Know...
To access help via a dialog box: e You can also press in a dialog box to
1. Display the dialog box access help specific to that dialog box.

2. Click on Help

© Learning and Development Service Page 12 Getting help
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OTHER SOURCES OF HELP

Microsoft Office 2010 applications are matter how much you know, you’ll still get
extremely sophisticated. They allow you to stuck from time to time. Fortunately, there is
perform everyday tasks with relative ease, a wealth of information out there for you to
but also have the power and grunt for very call upon.

specialised and advanced functions. No

Friends And Colleagues

Never underestimate the value of friends
and colleagues. If they have been using the
software long enough, there is a fair chance
that they will know a way around a problem
or at least know where to find help.

Reference Manuals

There are literally thousands of reference
books available for software applications.
These books can be found in the Computer
section of almost every bookstore in
Australia. They are often used as reference
books because they are too large and too
technical to read from cover to cover. While
they can be expensive, many people prefer
to keep one or two by their computers for
reference. They all have an extensive table
of contents and index to make searching for
topics relatively easy. Microsoft Press put
out manuals specifically for their own
software that vary in level from very
introductory to advanced.

Training Manuals

Training manuals focus more on how to do
things rather than provide a complete
i reference. They are usually written as a
\d

Morosor

¥ e series and in sequence, e.g. Level 1, 2, and
- 3, or Module 1 and 2. Good training
manuals provide step-by-step instructions
and plenty of screen shots so that you can
easily and quickly see where you are up to
and what you should have done. Many are
written to a particular curriculum or
accreditation syllabus and can be used for

examination preparation.
Computer Magazines

Since they are usually produced as monthly
publications, computer magazines and
journals provide the most up to date
information of all printed references.
Computer magazines are available through
newsagents or directly by subscription.
Some also have periodic supplements that
provide additional tips and information.
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CONCLUDING REMARKS

Congratulations!

You have now completed the Getting help booklet. This booklet was designed to get you
to the point where you can competently perform a variety of operations as listed in the
objectives on page 2.

We have tried to build up your skills and knowledge by having you work through specific
tasks. The step by step approach will serve as a reference for you when you need to repeat
a task.

Where To From Here...
The following is a little advice about what to do next:

Spend some time playing with what you have learnt. You should reinforce the skills
that you have acquired and use some of the application's commands. This will test
just how much of the concepts and features have stuck! Don't try a big task just yet if
you can avoid it - small is a good way to start.

Some aspects of the course may now be a little vague. Go over some of the points
that you may be unclear about. Use the examples and exercises in these notes and
have another go - these step-by-step notes were designed to help you in the
classroom and in the work place!

Here are a few techniques and strategies that we've found handy for learning more about
technology:

visit CLD’s e-learning zone on the Intranet
read computer magazines - there are often useful articles about specific techniques

if you have the skills and facilities, browse the Internet, specifically the technical
pages of the application that you have just learnt

take an interest in what your work colleagues have done and how they did it - we
don't suggest that you plagiarise but you can certainly learn from the techniques of
others

if your software came with a manual (which is rare nowadays) spend a bit of time
each day reading a few pages. Then try the techniques out straight away - over a
period of time you'll learn a lot this way

and of course, there are also more courses and booklets for you to work through

finally, don’t forget to contact CLD’s IT Training Helpdesk on 01243-752100
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